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Determination of the appropriate sample size is a crucial part of study design. We must 

choose sample size correctly to allow a study to arrive at valid conclusions for the 

scientific question. A study which is too small may produce inconclusive results, while a 

study which is too large will waste scarce resources. 適切なサンプルサイズを決定することは、試験デザインする上でとても重要な要素です。サンプルサイズが適切でなければ、科学的な問いに対し、理にかなう結論を得る研究をすることはできません。サンプルサイズが小さすぎれば、何も結果が得られない可能性があり、一方、サンプルサイズが大きすぎれば、希少なリソースを無駄にすることになります。 

 

Answering the question “What sample size do I need?” requires six steps. Using an actual 

example of determining sample size for the two-sample t test, this guide takes you 

through a step-by-step tutorial demonstrating some of the nQuery Advisor features. This 

guide is not meant to be an exhaustive demonstration of nQuery Advisor options. Rather, 

the tutorial demonstrates the general methods of nQuery Advisor through one complete 

example.  「必要なサンプルサイズはどのくらいなのか」という問いの答えに必要なのは、nQuery 

Advisorを使えば、たった7ステップです。このチュートリアルでは、nQuery Advisorのすべての機能の説明ではなく、２標本ｔ検定のサンプルサイズを決定するという一つのサンプル事例に沿って、基本的な機能を順次説明していきます。 

 

 
Step 1. Formulate the study         

ステップステップステップステップ1      試験デザイン試験デザイン試験デザイン試験デザインのののの作成作成作成作成 

 

The study question is: Does the new drug reduce anemia in elderly women after hip 

fracture? この試験の目的： 新薬が股関節骨折をした高齢の女性の貧血症を抑えるかどうか。 

 

Detail the study design        試験試験試験試験デザインデザインデザインデザインのののの詳細詳細詳細詳細決定決定決定決定 

 
A two-group, randomized, parallel, double-blind study is planned. Patients will be 

studied for two weeks; each patient will be randomly assigned to receive either new drug 

or placebo 3 times per week. The sample sizes in the two groups will be equal. 



二群、無作為化、平行群間、二重盲検試験を想定します。被験者は2週間経過観察されます。被験者は各々、無作為に新薬かプラセボを週三回投与されます。二群のサンプルサイズは同数とします。 

 

Choose the outcome summary    評価項目の評価項目の評価項目の評価項目の選択選択選択選択 

 
The primary outcome measure will be the mean change in hematocrit level from pre-

treatment to post-treatment. These changes will be compared between the two groups. 主要評価項目は、ヘマトクリット値の、投与前と投与後の平均値の変化です。変化を二群間で比較します。 

 

Specify the analysis method    統計解析方法の統計解析方法の統計解析方法の統計解析方法の指定指定指定指定 

 

The mean change in hematocrit level will be compared between the two groups of 

patients using the two-sample t test. The null hypothesis states that the mean change in 

hematocrit is the same in both groups. ヘマトクリット値の平均値変化を２標本ｔ検定を用いて二群間で比較します。帰無仮説を、ヘマトクリット値の平均値変化は、二群共に同じであるとします。 

 

Select File menu New option. In the Study Goal and Design Box, you will see three 

columns of options. 

File →Newを選んで下さい。Study Goal and Design(試験の目的とデザイン)のダイアログボックスが表示されます。上段に、三つの選択項目があります。 

 

Under Goal: Make conclusion using, select Means. 

Goal: Make conclusion using（結果を導くために使用するのは）のフィールドでは
Meansを選択します。 

 

Under Number of groups, select Two groups. 

Number of groups（群の数）はTwoを選択します。 

 

Under Analysis method, select Test. 

Analysis method(解析方法)は、Testを選択します。 

 

In the Study Goal and Design box below, the selections result initially in seven choices 

in the lower half of the Study Goal and Design dialog box. 上記の選択をすると、Study Goal and Designのダイアログボックス下段に、サンプルサイズの計算方法のリストが出てきます。８つの選択肢が表示されます。 

 



 
 

 

Different selections under “Goal” or “Number of Groups” or “Analysis Methods” bring 

up different lists of available sample size tables. 上段の3項目の選択を替えると、下段にはその選択に則したリストが表示されます。 

 

Select the Student’s t test (equal variances) and click on the OK button to accept the 

choice. You will see the following screen: 下段のなかから Student’s t test (equal variances)（スチューデントｔ検定(等分散)）を選択し、OKボタンをクリックすると、以下が表示されます。 

 



 
 

 

This is the sample size table for the two group t test of equal means with equal n’s. これは、二群のサンプルサイズが同じ場合の(?同平均値の?先日お送りいただいた訂正版にはこのことばが入っていませんでしたが、なしでもいいのでしょうか)２標本ｔ検定に対するサンプルサイズ計算表画面です。 

 

Menu Bar    メニューバーメニューバーメニューバーメニューバー 

 
The sample size table displays eight menus in the menu bar at the top of the window. The 

menus are: File, Edit, View, Options, Assistants, Plot, Window, Help. サンプルサイズ計算表画面のメニューバーには選択肢は以下の９つです。 

File, Edit, View, Options, Assistants, Randomize, Plot, Window, Help 

 

Column Numbers    列の列の列の列の数字数字数字数字 

 
Each column in the sample size table is labeled with a column number. You can change 

these default column names by using the Edit Column Names option from the Edit menu. 

Each table allows up to 20 columns for use.  サンプルサイズ計算表のそれぞれの列の最上段には数字が入っていますが、これをEdit→Edit Column Names（列名の編集）を選択して、数字以外の文字に書き換えることがで



きます。(日本語は不可と書いておいた方がいいのではないでしょうか)列は20まで追加できます。 

 

Row Names    行の行の行の行の項目項目項目項目 

 
Below the table title, the screen displays nine row names. Each row name specifies the 

type of value to be found in the row, whether you enter the value, or the program 

calculates the value for you. 表のタイトルの下、一番左の列には、項目が9行記入されています。それぞれの行の右に表示される数字の説明です。入力する場合も、プログラムが算出した数字が表示される場合もあります。 

 

Changing Row Names or Labels    行の項目行の項目行の項目行の項目またはまたはまたはまたはラベルの変更ラベルの変更ラベルの変更ラベルの変更 

 
You can change the row labels to replace Group 1 and Group 2 with the specific names 

for your groups. This option allows you to enter customized row labels for the groups. 

Your new row labels will appear both on the screen and in the saved and printed versions 

of your sample size table. 

Group 1 と Group 2のセルについては、ニーズに合ったグループ名に編集できるようになっています。画面上だけではなく、実際にサンプルサイズ計算表を保存しても、印刷しても、そのグループ名が反映されます。 

 

To edit row names:        行の項目を編集するには：行の項目を編集するには：行の項目を編集するには：行の項目を編集するには： 

 

Click on the Edit menu Edit Row Names option. The Edit Row Name dialog box will 

appear. 

Edit→Edit Row Names（行の項目の編集）をクリックします。 Edit Row Namesのフィールドが表示されます。 

 
 



Click on Group 1 mean,  µµµµ1111 and Group 1 will appear in the white rectangle in the center 

of the dialog box. Note that mean, µµµµ1111 appears to the right of the white rectangle so that 

you always know which mean you are specifying. 

Group 1 mean,  µµµµ1111をクリックします。中央に白い四角が表示され、そのなかに“Group 1”という文字が現れます。mean, µµµµ1111という文字が、その白い四角の右側に表示されるのを確認して下さい。どの平均値を選んでいるかがわかります。 

 

 

 
 

In the white rectangle, type New drug to replace Group 1, then click on the Accept Edit 

Row button. その中央の白い四角の中に、Group 1 の替わりに、New drug（新薬）と入力し、Accept 
Edit Row（行の編集許可）をクリックしてください。 

 

Click on Group 2 mean, µµµµ2222, enter Placebo in the white rectangle, and click on the 

Accept Edit Row button. The dialog box will show your new row name entries. 

Group 2 mean, µµµµ2222をクリックして、白い四角の中に、今度はPlacebo(プラセボ)と入力し、
Accept Edit Rowをクリックしてください。フィールド左の四角の中の項目が新しい名前に変更されています。 

 

 

 
 



Click on the Update Table Row Name button to update the table, and the sample size 

table will appear with the new row names. You will see those names in the next figure, as 

you specify parameters in Step 2. 

Note: You can use up to a maximum of 20 characters for the editable part of the row 

name. 

Update Table Row Name（表の行の名前更新）をクリックすると、サンプルサイズ計算表が新しい項目に変更されます。パラメータを説明する、ステップ2の画面はすでにこの名前に変更されています。 注） 項目の編集で使用できる文字数は20文字（日本語は不可）までです。 

 

Colors in the Sample Size Table        サンプルサイサンプルサイサンプルサイサンプルサイズズズズ計算表のセル計算表のセル計算表のセル計算表のセルのののの色色色色 

The rows for power, sample size, effect size, interval width which provide the answers to 

your sample size queries are highlighted with yellow on the screen. In the sample size 

tables shown in grayscale in this manual, the yellow highlighting shows as a pale gray. サンプルサイズ計算表では、power(検出力)、sample size(サンプルサイズ)、effect size(効果量)、および、これから算出される数字が入るセルは、黄色にハイライトされています。画面では黄色ですが、このチュートリアルは白黒印刷のため、紙面上では薄灰色になっています。 

 

For example, Effect size, Power, and n per group are yellow when you have the table for 

the Two group t test on your screen. If you enter all required information in the white 

rows, you can fill in any two of the three yellow rows, and nQuery will compute the third. 

For this example, enter the group means and the common standard deviation, nQuery will 

compute the corresponding effect size. Then enter either power or n per group, and 

nQuery Advisor will calculate the other. Any rows appearing white on your screen are 

the rows you can ignore, if you wish. 例えば、2標本ｔ検定の画面が出ている場合、Effect size（効果量）とPower（検出力）とn per group（群ごとのサンプルサイズ）が黄色になっています。白色の行に必要な数字をすべて入力すると、黄色の3行のうち2行が埋まります。 nQueryが3行目を計算します。 今回の事例の場合、二群の平均と共通の標準偏差を入力すれば、nQuery advisorがそれに対応する効果量を計算します。その後、検出力もしくは群ごとのサンプルサイズをインプットすれば、nQuery advisorが残りの一つの値を計算します。画面上の白色の行は、無視してかまわない部分です。 

 

Guide Cards        ガイドカードガイドカードガイドカードガイドカード 

The guide cards in the right pane of the nQuery Advisor window provide statistical 

information on the row in which your cursor lies. If you are unfamiliar with the analytic 



procedure or with doing sample size computations, or you want some help with how to 

proceed while filling in values for the table, refer to the guide cards. 

nQuery Advisorの右側にあるガイドカードには、カーソルがある行の統計に関する情報が表示されます。分析方法やサンプルサイズの計算がよくわからない場合、また、表に数値を入力する際どのように進めたらいいかのアドバイスがほしい時などに参考にして下さい。 

 

 
 

Note that the guide card corresponding to the top row provides general information about 

how to use the table. As you move the cursor from row to row, the guide cards display 

information appropriate for each row. You also get suggestions for row values, details on 

limits for the values you can enter, and reminders about other helpful nQuery Advisor 

features. 注）ガイドカードの一番上の行には表をどのように使用するかの概説が表示されます。カーソルを下に動かすと、ガイドカードはそれぞれの行に呼応した情報を表示します。また、行の数値に対する提案や、入力できる数字の制限の詳細、nQuery Advisorの他の役立つ機能についてのアドバイスなども表示されます。 

 

 

References    参考文献参考文献参考文献参考文献 

The References pane is directly below the Guide Card pane of the nQuery Advisor 

window. There you will find the references for the current sample size table. 参考文献のフィールドが、ガイドカードのすぐ下にあります。計算中の表に対する参考文献が表示されます。 

 

Statements    サンプルサイズ決定根拠文サンプルサイズ決定根拠文サンプルサイズ決定根拠文サンプルサイズ決定根拠文 

The Statements pane is directly below the References pane of the nQuery Advisor 



window. That pane is available for storing sample size justification statements 

generated by nQuery; these stored statements will be saved with the sample size 

table. This tutorial will demonstrate how to request Statements and store, print, or 

copy them to clipboard for pasting into other Windows applications. 

Reference(参考文献)のフィールドのすぐ下には、Statements(サインプルサイズ決定根拠文)のフィールドがあります。ここには、nQueryが算出したサンプルサイズ決定の根拠となる文章を保存しておくことができます。その文章はサンプルサイズ計算表と共に保存されます。このチュートリアルでは、サンプルサイズ決定根拠文を呼び出したり、保存したり、印刷したり、クリップボードにコピーして他のウィンドウズ対応ソフトに貼り付けたりする方法を説明していきます。 

 

Notes    メモメモメモメモ 

The Notes pane is directly below the sample size table pane of the nQuery Advisor 

window. In the Notes pane you can enter all necessary notes to be saved with the 

sample size table. 

Notes(メモ)のフィールドは、サンプルサイズ計算表のすぐ下にあります。ここに、必要なメモを書き込んで、サンプルサイズ計算表とともに保存することができます。 

 

Online Help    オンラインオンラインオンラインオンライン    ヘルプヘルプヘルプヘルプ 

The nQuery Advisor online Help is available at all times. To assess the Help through the 

menu bar, click on the Help menu Help topics option. 

nQuery Advisorは常時オンラインヘルプが可能です。ヘルプへのアクセスは、メニューバーの、HelpメニューのHelp topicsをクリックして下さい。(必要?) 

 

 



Step 2. Specify Parameters for Planned Analysis 

ステップ２ステップ２ステップ２ステップ２            分析のパラメータ分析のパラメータ分析のパラメータ分析のパラメータ指定指定指定指定 

 

For the two group t test example, the parameters you must specify for the analysis 

method being planned are: 今回の2標本t検定で、計画している分析に必要はパラメータは： 

• the significance level for the test 

• whether the test procedure is to be one or two-sided. 

• 検定の有意水準 

• 検定方法が片測検定なのか両測検定なのか 

 

Plans call for a 5% (α = .05) significance level and a two-sided test. 

To enter the values: 

Enter .05 into the first cell. 

Type 2 into the cell below. 有意水準5%(α = .05)で、両測検定を行う場合 数値入力： 第1列の最上段のセルに .05 を入力 その下のセルに 2 を入力 

 

Note that we can change the number of decimals displayed for specific rows in the table 

by choosing the Format Decimal Displays for Selected Rows option in the right click 

menu after highlighting the chosen rows. 表中には、小数点以下の表示桁数を変更できる行があります。 変更したい行をハイライトさせ、マウスを右クリックして、Selected Rows(行の選択)の
Format Decimal Displays(少数点以下の表示桁数を変更)を選択して変更します。 

 

 



 

In preparation for the next step, repeat your row entries of .05 and 2 for columns 2 and 3. 

The next section will use the three columns. 次のステップに進む準備として、.05と2を、第1列同様、第2列と第3列にも入力します。 次のセクションでは、数字を入力した第1,2,3列を使用します。 

 

Right-click Menus        右クリックメニュー右クリックメニュー右クリックメニュー右クリックメニュー 

As well as providing access to the usual right click menu functions such as Save, Undo, 

Print, etc., the right click menu in nQuery Advisor also includes specific functions such 

as Create Statement, Edit Row/Column Names and Format Decimal Displays for selected 

row options. 

Save（保存）、Undo（元に戻す）、Print（印刷）、等の通常の右クリックの機能のほかに、nQuery Advisorでは、右クリックに特別の機能が追加されています。 Create 

Statement(文章の作製), Edit Row/Column Names (行/列の名前の編集) と特定の行に限られますがFormat Decimal Displays (小数点以下の表示桁数変更) などです。. 

 

 
 

 



Step 3. Specify Effect Size for Test 

ステップステップステップステップ    ３３３３        試験試験試験試験の効果量のの効果量のの効果量のの効果量の指定指定指定指定 

 

Specifying the effect size is often the hardest part of study planning. 試験デザインする際に、効果量を指定することがとても難しいことがよくあります。 

 

For the two-sample t test, specifying the effect size has two parts: specifying the expected 

difference in means you would like to detect, and specifying the standard deviation 

expected within each group. 

 2標本t検定においては、効果量を指定ためするべきことが二つあります。一つは、検出したいと思う予想平均値の差を指定すること。そしてもう一つは、それぞれの群内の標準偏差を指定することです。 

 
Specifying the difference in means expected for the two groups 

二群二群二群二群のののの予想平均値の予想平均値の予想平均値の予想平均値の差差差差をををを指定指定指定指定するするするする 

 

You should specify the expected mean changes, the worthwhile mean changes, or the 

important mean changes. People often say, “This study has never been done before, so 

how do I know what will happen?” However, previous use of the intervention is not the 

important question. 予想される平均値の変化、または、重要な平均値の変化を指定する必要があります。「この初めてする試験なのに、予測などできない」と思われることが多いのですが、以前に介入したかどうかは、重要な問題ではありません。 

 

The important question is what is known about the outcome measure. What would be an 

important effect of treatment? What kinds of effects might be expected, given other 

information? 重要なのは、評価項目に関して何がわかっているのか、ということです。何が、治療に最も必要とされる効用なのか。他の情報は与えらている中で、どのような効用が期待されるのか、なのです。 

 

In this example, there was information on hematocrit from four prior studies: このチュートリアルの事例では、4つの既存の研究から、ヘマトクリットに関し以下の情報が得られています。 

 

1. From a small pilot study in six elderly females after hip fracture, the mean 

hematocrit was 32.3%. In the same institution, in 32 healthy elderly females, the 

mean hematocrit was 33.5%. 



1．少人数でのパイロットスタディでは、高齢の股間骨折をした女性6人の、ヘマトクリットの平均値は32.3%となっていた。同機関？では、健康な高齢の女性32人のヘマトクリットの平均値は33.5%であった。 

 

2. Two previous studies tested different doses of the new drug in other patient 

groups. In those studies, the placebo group showed no change in hematocrit. The 

treated group showed changes of 2.5% to 5%. 以前の2回の検定では、他の被験者の数グループに新薬を、それぞれ違う量投与した。この検定では、プラセボのグループは、ヘマトクリットの変化は何もなかったが、新薬を投与されたグループは、2.5%から5%への変化を示した。 

 

These data taken together suggest that we can expect a change of 0% in the placebo 

treated group, with treatment group changes lying in the range 2.5 to 5%. Thus, a 

conservative estimate of the possible effect of the new drug in elderly females might be 

in the range 2.0% to 2.4%. Such increases would be of real value to the patient. これらのデータを合わせると、プラセボを投与したグループの変化は0%と予測できます。また、新薬を投与したグループの変化は、2.5%から5%への変化です。つまり、高齢の女性の新薬による効用の可能性は、控えめに見て、2.0%から2.4%と考えられます。その増加値が、患者にとって実際に有意な数字だと予想することができます。 

 

To enter means:    平均値の入力平均値の入力平均値の入力平均値の入力：：：： 

 

Click on the cell in the first column of the New drug mean row and enter 2.0. 

In the second column of the New drug row, Enter 2.2. 

In the third column of the New drug row, Enter 2.4  

New Drug mean(新薬の平均)の行の第1列に2.0を入力します。 同行の第2列に2.2を入力します。 同行の第3列に2.4を入力します。 

You have entered the New Drug means. 

New Drug meanの入力は終了です。 

 

Enter 0 in all three columns for Placebo mean row. 

Placebo mean(プラセボの平均)の行の第1,2,3列にはすべて0を入力します。 

 

Note that nQuery Advisor automatically calculates the difference in means, as you can 

see in the next screen. 

nQuery Advisorが自動的に平均の差を計算します。下の、画面の図をご覧ください。 

 



 
 
 
Specifying the common standard deviation 共通の共通の共通の共通の標準標準標準標準偏差偏差偏差偏差のののの指定指定指定指定 

 

The next row in the table is Common standard deviation, so we must obtain 

information about variability between individuals within a group. The two-sample t test 

assumes that variability in the two groups is the same, so you enter a single value. 表の次の行は、Common standard deviation(共通の標準偏差)です。一群内の個人間の分散についての情報を得る必要があります。2標本t検定では、二群は等分散と仮定しますので、同じ値をいれます。 

 

In determining the value of the common standard deviation, we again refer to previous 

studies. Standard deviations for hematocrit values were 3.2% in elderly females, and 3 to 

6% for other groups. 共通の標準偏差の値を決定する場合もまた、既存の研究を参考にします。ヘマトクリットの値の標準偏差は、高齢者の女性は3.2%、他のグループでは、3%から6%の値になっています。 

 

The current study, however, requires the standard deviation for change in hematocrit, and 

less information is available. The information reported here required some additional 

calculations from the values given in the references. The standard deviation of change in 

hematocrit in the various placebo and treated groups ranged from about 1.5% to 2.5%. 

These data suggest that we can reasonably expect a standard deviation for change in 

hematocrit of about 2%. 



今回の事例の試験ではヘマトクリットの変化の標準偏差が必要となるのですが、情報が不十分です。そこで、参考文献にある値を取り出し、追加の計算が必要となります。プラセボを投与されたグループと新薬を投与されたグループのヘマトクリットの変化の標準偏差は1.5% から2.5%の範囲です。これらのデータから、ヘマトクリットの変化に対する標準偏差が2.0％あたりで妥当であるとあると予測できます。 

 

The nQuery Advisor program helps you to utilize information from a variety of formats 

to obtain an estimate of the standard deviation 

nQuery Advisorを使うと、さまざまな情報を有効利用して、標準偏差の予測値を得ることができます。 

 

To enter Common standard deviation: 

共通の標準偏差を共通の標準偏差を共通の標準偏差を共通の標準偏差を入力入力入力入力するするするする 

 

Click on the cell in the first column of the Common standard deviation row and enter 

2.0. 

Type 2.0 in the second and third columns of the Common standard deviation row. 

Note that nQuery Advisor automatically calculates the Effect size. 

Common standard deviationの行の第1列のセルをクリックし、2.0を入力します。 同行の第2列のセルにも第3列のセルにも2.0を入力します。 

nQuery Advisorが自動的に、効果量を計算します。 

 

At this point, you may wish to enter notes concerning the origin of these values for the 

mean and standard deviation so that you can document them in your report. You can save 

any notes with the table, then print them out or copy them to the clipboard for future 

reference. この時点で、今後のために、平均値と標準偏差の出所に関するメモを書こむことができます。ここまで入力した表とともに、さまざまなメモを書き込み、保存したり、印刷したり、コピーしてクリップボードに保存し、後々の参考にすることもできます。 

 

To add a note to the table: 

メモメモメモメモを書き込むを書き込むを書き込むを書き込む 

 

Click in the white rectangle in the lower left of your screen below the title, USER 

NOTES for MTT0-1 サンプルサイズ計算表の左下、USER NOES for MTT0-1というタイトルの下をクリックします。 

 

Type: References 1-5 suggest change in hematocrit due to the new drug treatment of 

2% to 5% and standard deviations of change from 1.5 to 2.5%. 



References 1-5 suggest change in hematocrit due to the new drug treatment of 2% to 5% 

and standard deviations of change from 1.5 to 2.5%.（1から5の参考文献は新薬の投与によってヘマトクリットの変化が2%から5%なり、標準偏差の変化が1.5%から2.5%になったことを示している）と打ちこみます。 

 

Your nQuery Advisor table should look like the following screen. そこまで入力すると画面は以下のようになります。 

 

 
 



Step 4. Compute: Sample Size or Power 

ステップステップステップステップ4        サンプルサイズと検出力の計算サンプルサイズと検出力の計算サンプルサイズと検出力の計算サンプルサイズと検出力の計算 

 

Choose the value of power required for the study. The power is the probability that the 

results of your study will be statistically significant at the specified significance level if 

your assumptions about means, standard deviations, and effect size are true. The 

significance level is 5% for this example, and we are assuming that the values you have 

entered for means and standard deviation are the true values (not necessarily those 

observed in your study). 試験に必要な検出力の値を選択します。検出力とは試験の結果が、平均値の推定、標準偏差、効果量が間違いでない場合に、統計的にある特定の有意水準において、十分に有意性があるという確率です。このチュートリアルの事例では、有意水準が5%ということになっています。また、入力した平均値、標準偏差は間違いのない数字だと仮定しています(必ずしも試験において得られた数値である必要はありません)。?? 

 

Investigators typically request study powers between 80% and 95%. The higher the 

required power, the larger the required sample size. Here, we assume that the investigator 

chooses 90% power. 試験では通常、検出力に80%から95%の範囲の値が求められます。検出力を高くすればするほど、サンプルサイズは大きくなります。ここでは、90%を選択します。 

 

To enter a value for Power: 

検出力の数値入力検出力の数値入力検出力の数値入力検出力の数値入力 

 

Click on the cell in the first column of the Power row and type 90. 

Type 90 into the second and third columns of the Power row. 

Power の行の第1列のセルに90を入力します。 

Powerの行の第2列にも第3列にも90を入力します。 

 

Note that, when you type the value 90 into the power row and press <Enter> or the right 

arrow, nQuery Advisor computes the necessary sample size and completes the column. 

90という数値をPowerの行に入力して、エンターキーを押すか、または、右向きの矢印を押すと、nQuery Advisorが求めるサンプルサイズを計算し、結果が列に表示されます。 

 

 



 
 

For the range of hypothesized changes in the new drug group, a sample size per group of 

16 to 23 would be required (total study sample sizes of 32 to 46.) In the next section we 

illustrate easy ways to evaluate a variety of possibilities for other scenarios and sets of 

analysis parameters. 新薬を投与されたグループの仮定の変化に関しては、16から23のグループごとのサンプルサイズが必要だという結果がでました。（合計サンプルサイズは32から46）。次のステップでは、他の仮定と様々な分析パラメーターの確率の値を求める簡単な方法を説明します。 

 



Step 5. Plots in nQuery Advisor 

ステップステップステップステップ    5     nQuery Advisorのプロットのプロットのプロットのプロット 

 

Use Plot Options    プロットオプションの使い方プロットオプションの使い方プロットオプションの使い方プロットオプションの使い方 

To use the Plot option to see n per group for different powers: 異なった検出力に対する群ごとのサンプルサイズを見るためのプロットオプションの使い方 

 

Use the mouse to highlight the entire second column of your sample size table.  マウスを使ってサンプルサイズ計算表の第2列をすべてハイライトします。 

 

Click on the Plot menu Plot Power vs n option. The plot for the chosen column will 

appear. 

Plot→Plot Power vs n option（検出力とｎオプションの対比）をクリックします。選んだ列のプロットが表示されます。 

 

 
 



It is very simple to change attributes such as plot title and axes labels or to change the 

appearance of the plotted lines or background. Full details of how to edit the nQuery 

Advisor plots are available in the nQuery Advisor manual. プロットのタイトル、軸のラベル、線、背景は簡単に変えられます。細かな編集につきましてはマニュアルをご覧ください。 



Step 6. Choose Sample Size, Write Statement 

ステップステップステップステップ6        サンプルサイズの選択、サンプルサイズの選択、サンプルサイズの選択、サンプルサイズの選択、    そのそのそのその決定根拠文の決定根拠文の決定根拠文の決定根拠文の作成作成作成作成 

 

The nQuery Advisor program writes up the sample size decision for any chosen column. 

This feature makes it easy for you to report your sample size decisions in correct 

language. 

nQuery Advisorは選んだ列に対して、サンプルサイズを決定根拠文を表示します。 これによって、容易に、正確な文章で、サンプルサイズ決定の根拠をレポートに書くことができます。 

 

To create a sample size justification statement: 

サンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠文文文文のののの作成作成作成作成 

 

Select any single completed column in your sample size table. For this example, select 

the first column. サンプルサイズ計算表の中から、一つ、数値挿入済みの列を選びます。この事例の場合、第1列を選択します。 

 

Click on , the Edit menu Create Statement option. The statement will appear in the 

Statement dialog box. 

Edit → Create Statement（文書作成）クリックします。Statementのフィールドが表示され、その中にサンプルサイズ決定根拠文が表示されます。 

 

 
 
 
Buttons in the Statement Dialog Box 

Statementフィールドのフィールドのフィールドのフィールドの下のボタンについて下のボタンについて下のボタンについて下のボタンについて 

 

Store    保存保存保存保存 

To store the statement with the sample size table: サンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠文とサンプルサイズ文とサンプルサイズ文とサンプルサイズ文とサンプルサイズ計算表計算表計算表計算表を保存するには：を保存するには：を保存するには：を保存するには： 



 

Click on the Store button to send the statement to the Statement pane of the sample size 

table. 

Storeボタンをクリックすると、その文章が、サンプルサイズ計算表画面のStatementのフィールドに移動され、保存されます。 

 
 

Now when you save the sample size table, you will save the statement with the table.   サンプルサイズ計算表が保存される際に、その文章も保存されます。 

 

After you have stored the statement with the sample size table, you can choose 

to print the statement or not, whenever you print the table. サンプルサイズ計算表と共にその文章を保存した後、計算表を印刷するたびにその文章を印刷するかどうかを選択することができます。 

 

Print        印刷印刷印刷印刷 

 
To print the statement from the Statement dialog box: 



Statement    フィールドフィールドフィールドフィールドににににあるあるあるあるサンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠サンプルサイズ決定根拠文文文文を印刷するを印刷するを印刷するを印刷する 

 

Click on the Print button to bring up the Print dialog box. 

Click OK to print the statement. 

Printボタンをクリック→Print dialog box のOKをクリックします。 

 

 

To Clipboard    クリップボードに保存するクリップボードに保存するクリップボードに保存するクリップボードに保存する 

 
To use the statement in the statement dialog box with another Windows application: 

Click on the To Clipboard button to send the statement to the clipboard for pasting into 

another Windows application. 

Statement フィールド内のサンプルサイズ決定根拠文を別のウィンドゥズ対応ソフトに使用する場合は、To Clipboard（クリップボードへ）ボタンをクリックして、クリップボードに保存し、それを、コピーしたいソフトに貼り付けます。 



Step 7. Use Table, Statement, References, Plots in Study Protocol, and 
Save Table 

ステップステップステップステップ    ７７７７      表、説明文、参考文献、図表を表、説明文、参考文献、図表を表、説明文、参考文献、図表を表、説明文、参考文献、図表を試験プロトコルに試験プロトコルに試験プロトコルに試験プロトコルに使用し使用し使用し使用し、、、、計算計算計算計算
表表表表を保存を保存を保存を保存 

 

You can insert the nQuery Advisor tables, statements, references and plots directly into 

your study protocol. You can print them directly (as described under Step 6), and you can 

save them to a file for later access and editing with nQuery Advisor. 

nQuery Advisorの計算、サンプルサイズ決定根拠文、参考文献、図表を、直接、試験プロトコルに組み入れることができます。ステップ6にあるように、直接印刷することもできますし、別のアプリケーションのファイルに保存し、後に使用したり、nQuery 

Advisorを使って編集することもできます。 

 

To paste the table into your study protocol: 

試験プロトコルに計算表を貼りつける 

 

Choose the File menu (or right click menu) Print table to clipboard option. 

File(もしくは、右クリック)→→→→Print table to clipboardを選びます。 

 

Click OK, Complete Copy 

OKとComplete Copyをクリックします。 

 

Open the word processing document and paste the table into the document. 別のワープロアプリケーションを開き、そこに、表を貼りつけます。 

 

We show the pasted table below.       以下は、貼り付けた表です。 

 
  Two group t-test of equal means (equal n's) 

1 2 3

  Test significance level, αααα   0.050   0.050   0.050

  1 or 2 sided test?    2    2    2

          New Drug mean, µµµµ1     2.000     2.200     2.400

          Placebo mean, µµµµ2     0.000     0.000     0.000

      Difference in means, µµµµ1 - µµµµ2     2.000     2.200     2.400

      Common standard 

deviation, σσσσ 

    2.000     2.000     2.000

  Effect size, δδδδ = |µµµµ1 - µµµµ2| / σσσσ     1.000     1.100     1.200

  Power ( % )      90      90      90
  n per group  23  19  16
 



 
You can paste references, sections from guide cards, notes, and statements into your 

document in the same way. 参考文献や、ガイドカードに書かれていること、メモ、サンプルサイズ決定根拠文も同様に、別のソフトに貼り付けることができます。 



Summary        終わりに終わりに終わりに終わりに 

 
This tutorial has introduced you to several of the nQuery Advisor features by using one 

complete example. You should now have a good overview of the nQuery Advisor 

program and its mode of operation. However, please keep in mind that nQuery Advisor 

offers many features not discussed in detail or even mentioned in this guide. See the 

nQuery Advisor manual for details and examples of the other available options. 

 このチュートリアルでは、nQuery Advisorの機能のうちのいくつかを、事例を用いて紹介しました。これでnQuery Advisorの大まかな機能や、使い方はおわかりいただけたと思います。ここには詳しく説明されていない機能や、全く触れられていない機能もありますので、他の試験例や詳しい使用説明は、nQuery Advisorマニュアルをご覧ください。 


